
Using Netlogger for Logging Ham Radio Traffic Nets
Written By Daryl Stout, N5VLZ

This was prepared for the Net Mexico D-Star Net, but this can be used with 
any amateur radio traffic nets. The file was last updated on Oct. 16, 2023. The 
file was updated, due to changes in the nets done by N5VLZ during the week, 
and other cosmetic changes (it would help if I got my callsign right (hi hi)).

This is a basic guide for setting up, and using Netlogger with nets. While there 
are YouTube videos out there, many program authors, unfortunately, are far 
more technically savvy, than most folks. So, that’s why I’ve prepared this file. 
I do NOT cover everything that Netlogger does...this file is designed to get 
folks set up to use it, to monitor and checkin to nets, or to run a net as a Net 
Control Station.

I know there are numerous other logging programs available, and every Net 
Control is free to choose whichever program(s) they desire. Thanks to Jeff, 
VE6DV...Larry, NN4H...Paul, K9PTF...El, K4DJL...and Steve, KC9SIO... 
among others, for their advice and help with setup and use of Netlogger. Each 
of the hams noted uses Netlogger with their nets.

I don’t use Netlogger for anything besides nets; but, it can be used for other 
things, such as contesting and/or contacts. You can also do the following items 
in “stand alone mode”, although some settings can’t be changed in this mode:

1) Import or export the logs via CSV or ADIF files to eQSL and LoTW; or 
with delimited files that can be viewed in a utility such as Windows Notepad. 

2) Set up a Club Information File for your particular net, and it’ll use the 
information from that file, rather than pulling it off of QRZ, eQSL, or LoTW 
(Logbook Of The World – ARRL Membership required to use LoTW).

3) Set up a pre-net checkin file, for stations that are courtesy checks, short 
time stations, etc., and save it to a separate file with all the needed info or 
remarks prior to the net. Then, you just load that log file, and choose create 
net (noted later in the document), and you’re ready to go.



Netlogger is a freeware program, used by several amateur radio operators for 
logging traffic nets, contesting, etc...and versions are available for Windows, 
Linux, and Mac. 

This PDF file is a quick start guide to setting it up and using it. I’ve utilized a 
sample net checkin log that I created for the “color guide”, and that info is 
also in a separate file.

As a side note, the box to the left of the Minimize (underscore _ icon) on the 
top of some screenshots is with a utility called Display Viewer. It allows the 
moving of items between multiple monitors, so you don’t have to try and 
cram several items onto one screen. There’s a free version, but the registered 
version to allow use on multiple computers, is worth the cost. It’s a lifetime 
registration, so when there are upgrades, there are no new fees. Info is 
available at https://www.binaryfortress.com/support 

The latest version of Netlogger can be found at https://www.netlogger.org –
the graphic that you will see is in the screenshot noted below. You can choose 
to Download The Program, Contact Support, or Join The User Groups. A 
display of current nets in progress with Netlogger is also shown on the main 
page.

Click on the “down arrow” to get the program. Choose the version, and your 
operating system (Windows, Linux, or Mac)...then enter your callsign, and an 
email address. Save the link to your download area, then double click on it (or 

https://www.binaryfortress.com/support
https://www.netlogger.org/


right click on it, and click Install) to run the installation program. You’ll need 
to accept the license agreement to proceed with the installation. In short, if 
you don’t want to accept the agreement, you might as well stop reading this 
file, and close your PDF viewer now.

It may take several minutes to download and install the program, depending 
on the speed of your internet connection, and your computer’s CPU. Note 
that DSL or broadband is far better than dial-up internet, especially “if the 
meter is running”. Once downloaded and installed, the first time you run it, 
it’ll ask for your callsign and name. You can leave it blank, if multiple hams 
use the setup on your computer.  But, the creation of a profile is OPTIONAL, 
and it’ll show NONE if no profile is created. Club Info Profiles will be covered 
toward the end of this document. 

Now, on to the basic operations...monitoring, creating, and running a net.
When you double click on Netlogger, you’ll see the screenshot noted below, 
with your created profile.



Note that the “Contacts” window at the bottom I normally do NOT use, as it 
automatically sets the checkin color to “Worked Station Manually”. As a 
result, I’m not covering this section of Netlogger in this file, and you won’t see 
it in my screenshots. If you wish to use that option, you are free to do so.

To Monitor A Net In Progress, choose “Select Net”, then click on the desired 
net, and choose Monitor Net. 

Below are the screenshots that you will see with the “Select Net” option. This 
was taken around 0350 UTC Sunday, Dec. 20, 2020. The nets change during 
the day of the week, and for the time of day. Netlogger can be used on RF 
(HF/VHF/UHF), VoIP (CQ100, Echolink), Digital (D-Star, DMR, Fusion, 
NXDN, etc.), or another mode. 

Basically, using Netlogger increases the “visibility of your net”. However, you 
may get some stations that “troll” Netlogger for nets (dropping as soon as 
they connect), just request a “short time checkin”. Or, they may not have the 
means to checkin...whether it’s RF, VoIP, digital, etc.

You will see the Net Name, Frequency, Mode, Server, Net Control, Logger, 
Band, Start Time, IM (Almost Instant Messenger, noted below) Enable, 
Update Interval, and Subscribers (those logged on).

At the bottom of the screen, you’ll see the status of the servers...the colors 
indicate whether or not they’re available/online. You can adjust the time for 
net polling as desired. This is noted at the top of the next page.



To monitor a net, click on the desired net, and click Monitor Net. 

The program has an “Almost Instant Messenger” (AIM) window where you 
can chat with those logged on...whether you are monitoring a net, or running 
one. This can be Net Control, or others who are also monitoring the net. What 
the IM does is to allow chatting and other comments during the net, such as 
providing links on net related topics, advising Net Control that they can’t 
hear a certain station, or telling Net Control they need to be short time, or 
they need to check out from the net. To view these stations, click on View 
Monitors. You can uncheck the box if you don’t want to see the “Offline” 
stations. Screenshots for the monitor windows are shown below, and on the 
upcoming pages. You might see this on a particular net:

The station with the red number would be your callsign in the setup. From 
the graphic on the previous page, stations are shown with their callsign or ID, 
name (if provided), what version of Netlogger they’re running, their computer 
operating system (W for Windows, M for Mac, and L for Linux), and their 
status, as follows:



! Lurking – They have connected to monitor the net, but are not yet “checked 
in” (typed into Netlogger) by Net Control. 

! Checked In – Net Control has logged them, or they have checked into the 
net. They are online with Netlogger at the time.

! Checked Out – They were a courtesy checkin to the net, or have checked out 
after one round (F5, noted later in this document).

! Offline – They originally connected, but they’ve dropped the connection to 
Netlogger; yet, they were still logged by Net Control.

Below is an AIM window screenshot that you might see during a net.

The text colors from the window above are as follows:

Gold: Comments from the current “operator” at your end.

Cyan: Status updates when a station logs on to, or off from Netlogger, plus 
when logging is started or stopped.



White: Comments from other stations in the chat room.

Green: Usually with comments from other stations, a URL you can click on. 
Obviously, be careful what URL’s you click on, and be sure your computer 
virus protection software is current.

Messages are typed in the bottom window. It might take a minute after you 
hit <ENTER> for the message to go across, depending on your internet speed; 
although other stations may see your typed comment before you do.

Thanks to Paul Miller, ZL2BEZ, you can do emoticons with AIM in 
Netlogger.

Prior To Starting A Net:

Before starting or creating a net, if you have a large number of “regular pre-
net checkins” or stations who are courtesy checks, short time, etc. -- you can 
enter all their callsign info as if it was a regular net already in progress, even 
though you’re entering the data in “stand alone mode”. 



If you already have an account on either QRZ, eQSL, LoTW (Logbook Of 
The World (ARRL Membership required))...or 2 or all 3 of these; and you’ve 
set up your logon credentials in Netlogger); once you enter the callsign of the 
amateur radio station, the data will automatically be entered for you, unless 
the servers (QRZ, eQSL, LoTW, or Netlogger) are offline. The item for 
changing the [no club info] in the Remarks section, is noted later in this 
document. Basically, this saves time, where you don’t have to enter all this 
after you’ve started the net. 

When done preparing this pre-net checkins file, you choose SAVE AS a log 
file...name it whatever you like. Then, prior to the net, choose LOAD checkins 
file, select that file, then choose “Create Net”, noted on the next page. 

To start a net, select “Create Net”, and you will see the screenshot that is 
shown on the next page. The net data includes the net name, server cluster 
(Netlogger, etc.), net password (the net password and verify password must 
match), the callsign of net control, frequency, mode, and band. It’s helpful to 
enter the net frequency, reflector, etc., so other stations will know where to 
find the net. Note that nets can be run either on RF (HF/VHF/UHF), via 
“internet radio” (D-Star, DMR, CQ100, Echolink, etc.), or with various 
modes. You’ll enter the desired data for your particular net. 

As an example, I used “The Food Net” that I previously did on Saturday 
afternoon...that net has since gone QRT due to various issues.

Once you hit OK, the program changes from Standalone Mode to Logging 
Mode, and it’s recorded on the Netlogger site. If you had entered data in error 
before you hit OK, you can change it in logging mode (such as the net name, 



frequency, mode, band,  and callsign of the net control and logger), even while 
the net is in progress. If you wait too long to fill out the fields, the system will 
show an error message, and you’ll have to enter this data again.

As for the password, the Net Manager can decide on a common password for 
the net controls...or the Net Controls can use their own. Note that if the latter 
option (individual passwords) are used, it’s advised to let the other net control 
stations of what their chosen password is...so, if they need to take over with 
logging or net control during the net, they can do so. For security reasons, the 
password is not displayed. However, as noted above, if the system detects the 
password doesn’t match, you’ll be shown an error message, and have to re-
enter the passwords.

The “net password” feature allows only authorized Net Controls to modify 
the log. Otherwise, a “renegade ham” could mess up the log big time. If it’s a 
shared net password, it should be easy for the net controls to remember, but 
difficult for anyone else to guess. If you’re in “Monitoring” mode, if you click 
on “Start Logging”, you’ll be asked for the “net password”. The original Net 
Control Station can upgrade the status of a station to logger via the AIM 
client, or they can ignore a certain station, such as SWL entries. Normally, on 
ham radio nets, you don’t want to log “non-hams”.

WARNING!! Do NOT send the net password in the AIM Chat Window in 
Netlogger, or on D-Rats. Otherwise, stations connecting to these will see it!! 
Instead, send that via email, or a related messaging utility, such as a text 
(SMS) message via smartphone, Facebook Messenger, via email, etc.

A new set of “10 checkin slots” is added after the 9th, 19th, 29th, etc., checkin.

The status colors in the screenshot below (Operator, Net Control, Logger, 
VIP, Worked Station Manually, Worked Station Next, Relay Station, Not 
Heard, Short Time, Courtesy Check, No Response, etc.) are hard coded into 
Netlogger. As a result, those colors can NOT be changed. 

Net controls can use as many, or as few of these “colors” desired with their 
setup. These were compiled from a sample of net checkins to the various nets 
that I do.

Also, the columns that I use now are as follows (screenshot on next page):



# - The numeric entry of the checkin.
Callsign – The callsign of the station (I don’t log SWL stations).
State – The US State or country ID where they are located.
Preferred Name – Whatever the station prefers to be known as.
Remarks – This is where I put the Status of the station, traffic, etc.
City – The city where they are located.
Name – Their full name in the callsign records.
Country – The country where they’re logged in from.

Within the settings, you can choose which of these columns you wish to use.

I don’t use the Status column anymore, but it’s shown on the screenshot on 
the next page as a guide of what to look for. I indicate the station status in the 
Remarks Column instead.

The ones that I use (with the function keys, if applicable) are as follows – note 
that with some nets, more than one entry may be in the status column – again, 
the colors are “hard coded” within Netlogger, and can NOT be changed. As 
noted, I do not use the “status” column in my nets anymore as of Feb. 6, 2022. 
However, you can still set the station status (noted below) within the checkin 
window for that station.



! Pink – Current station addressing the net. If Net Control is making changes 
to the log, while a certain station is addressing the net; this color may “move 
around”. This color is not shown in my “screenshots”. Stations who may be 
monitoring the net will see the Pink bar, while the net is in progress. This way, 
they know where Net Control is on the net log.

! Dark Cyan – Operator (you). You likely entered your callsign when you ran 
the program for the first time. If this is on a net that you’re running (if you’ve 
noted yourself as Logger and/or Net Control), you won’t see this color. This is 
noted as (op) in the status column...especially if you check on other nets to 
monitor them. This is position 1 in the screenshot noted above. This setting 
will show on your computer with your callsign ONLY. It will be likewise for 
other stations who are logged on to Netlogger from their own computer.

If you “recover the log” after the net has been closed (this is covered later in 
this document), this status won’t show up. But, the Netlogger servers act as a 
backup, for you to reconstruct the logs for a particular net, if your computer 
crashed after Net Control closed the net, and you didn’t save the log as a 
screenshot. That’s better than having to rebuild the entire log from memory!!

The Net Official Status variable, noted below, is set by moving the cursor to 
the “Status” column (if you’re using it), or to a column of the desired station, 
and “right clicking” the mouse. From there, look for the “Net Official Status” 
option. Then, choose either Net Control, Logger, Relay, or VIP Status...all 
noted below. 

! Dark Purple – Net Control. This is set by the Net Official Status variable.   
This is noted as (nc) in the status column. If Net Control is doing both Net 
Control and Logging, only this color will show up. This is position 2 in the 
screenshot noted earlier.

! Light Purple – Logger. This is set by the Net Official Status variable. This is 
noted as (log) in the status column. If another station is Net Control, and you 
are logging, you’ll see this color...and the Net Control color, noted above. If 
Net Control is also logging, this color won’t be shown, but (log) still shows up 
in the status column. This is position 3 in the screenshot noted earlier.
! Orange – Relay Station. This is set by the Net Official Status variable, and is 
for a station who relayed in a certain station as a checkin...they were relayed 
in by another station...or they checked in via Netlogger, but couldn’t checkin 



via the “mode of the net”. This is noted as (rel) in the status column; and is 
done for “weak signal stations” (on the fringe area of the repeater, etc.). I’m 
also using this for stations who may have more than one callsign, as well as 
for “Late Checkins” (stations who “checked in” after the net was closed). This 
is position 4 in the screenshot noted earlier. I also use this for checkins via 
email, or the Facebook group “extended checkin window” (they checked in 
long after the net had closed).

! Dark Red – VIP Status. This is set by the Net Official Status variable. It can 
be for those who are Net Control operators for other nets...or for officers for a 
club or organization. This is noted as (vip) in the status column. To me, Net 
Controls and officers deserve recognition; as many times, it’s a thankless job. 
This is position 5 in the screenshot noted earlier.

! F3 – Red Orange – I’ve decided to use this entry for stations who are QRP, 
Mobile, Portable,  YL’s, first responders, military, or even a Special Event 
station, that’s checking into the net. This is noted as (W) in the status column, 
and is position 6 in the screenshot noted earlier. Mobile stations may drive out 
of the net coverage area during the net...and Special Event stations may have 
other stations trying to make contact with them...so I try to get to these first. 

! F4 – Light Green – I’ve decided to use this for stations with announcements, 
bulletins, or traffic for the net...before getting to other stations. This is noted 
as (n) in the status column, and is position 7 in the screenshot noted earlier. 
Then, if I do a brief summary of the net, I can highlight such traffic that was 
noted, for those who may have missed the net...then they can inquire of the 
station that passed the traffic, for more information.

! F5 – Gray – Courtesy Check, or for they checked out after 1 round (if multi-
rounds on the net). This is noted as (c/o) in the status column. Some nets that 
I do only 1 pass through the log, others have at 2 or more rounds but that’s at 
the Net Control’s discretion. This is position 8 in the screenshot noted earlier. 
If the station is still connected via Netlogger, and this option is chosen, it’ll 
show as “Checked Out” in the AIM Window, as noted earlier.

! F6 – Yellow – Not Heard. This is noted as (n/h) in the status column. This 
can also be used if the station had issues with their rig, Hotspot, Raspberry Pi, 
ZumSpot/OpenSpot, or their internet connection. This is position 9 in the 
screenshot noted earlier. I use this option if they don’t respond the first time, 



to make a note to go back to them; if they ask me to “come back to them in a 
few minutes”, such as they have to take an incoming phone call...or if they’re 
in for “one round only”.

! F7 – Light Cyan – Short Time. This is for in and out stations. This is noted 
as (u) in the status column (unavailable). I also use this for stations checking 
in from a particular net’s Facebook group. Bear in mind that not everyone 
may have access to a radio for a net checkin...but, they’d still like to be noted 
as “a bean for the count”. This is position 10 in the screenshot noted earlier.

! F8 – Dark Green – No Response. This is after multiple calls for stations who 
were originally “Not Heard”. This is noted as (n/r) in the status column. This 
is position 11 in the screenshot noted earlier. Netlogger checkins who dropped 
the connection immediately after connecting via the AIM client, are noted 
with this designation (basically, these are “net trolls”).

! White – Regular Checkin. You place whatever comments you wish in the 
Remarks section, if desired. Unless you have set up “club station information” 
for stations (which will be covered toward the end of this document), the 
default display will be “no club info”. This is position 12 in the screenshot 
noted earlier. No function key is used, and nothing is noted in the status 
column for this entry.

! F9 – Clear the Status Entry. This is useful for switching from “Not Heard” 
to “No Response”, or when they did show up for comments after all. 

If you entered the wrong callsign, the command for “Clear Entry” will clear 
data on the entire line; and the command for “Delete Entry” will delete the 
entire line. You can also choose “Insert Entry”, such as you need to make a 
new entry between slot 9 and 10...which will make a new #10 entry, and move 
#10 to #11...and of course, that moves any checkins below that done one slot.

Again, you may use as many or as few of the options that are noted above, as 
you so desire…changing these around to suit your taste, preference, etc.

Net Control can enter whatever info/data they wish in the Remarks column 
(club or organization membership, the mode used at checkin, their status, net 
control for another net, club officer, net manager, mobile, portable, short of 
time, not heard, no response, etc.). As noted earlier, if nothing is typed in the 



Remarks Section, unless you’ve set up the Club Information entries (detailed 
toward the end of this document), it will show up as “[no club info]”. 

Several choices are under “Club Award Status” (which like the Net Official 
Status, as noted above) are gotten to by moving the cursor to the “status” 
column, then “right clicking” the mouse. The categories noted are military, 
first responders (police, fire, paramedic), 18 wheel mobile (truck driver), 
clergy, YL (female ham radio operator...although I guess you could use the 
same for a married female ham radio operator (XYL)), museum ship, and 
QRP, among others. For these, or for a Mobile or Portable Station, I note 
such in the Remarks Column...and as noted above, I note them with the F3 
(worked station manually) command; as I wanted a different “color code”, 
anyway. I have not seen a noted color code for these stations.

Sorting Data and If The Checkin Order Goes from “Sequential To Skewed”:

You can sort the data, by clicking on the top of the column, such as callsign, 
state, preferred name or regular name, remarks, city, status, country, etc. The 
most practical use of this is with State or Country (you had checkins from the 
United States, Canada, the UK, Australia, etc.). You can do this right at the 
END of the net, if you want a “quick alphabetical summary” of checkins by 
state or country. This also works for the “Monitors” Window.

However, don’t be alarmed with Netlogger “skewing the numbers” by doing 
that. To get it back to sequential, click the mouse above the # sign in the left 
hand column. You may have to do it more than once, but it’ll restore things to 
sequential order. This means 1, 2, 3, 4, 5, etc. – instead of 1, 11, 12, 13, 14, etc. 
This works for both the regular checkin window, and the Monitors window.

Closing A Net:

When the net is set in Logging Mode, there’s a value in the timeout column. 
Basically, if no data is entered within that value, the system will automatically 
disconnect you. However, failing to disconnect from Netlogger when the net is 
done, or leaving a net without advising Net Control that you need to secure, is 
like leaving a party without bidding the host “adieu”, and considered rude. 
Exceptions are OK for power outages, weather or health issues, or other 
emergency situations.



It’s wise to have a backup Net Control, and give them the net password, in 
case you have to bail out as Net Control (an emergency traffic situation 
(weather, medical, etc.) has developed at your location), and turn it over to 
them...first notify them that you are switching Net Control to them. The 
backup Net Control station will then enter the password, and take over the 
net, and they will close the net when completed. You can then click on Stop 
Logging, Stop Monitoring, then exit the Netlogger program. Do NOT click on 
“Close The Net”...the backup Net Control (now primary Net Control) will 
take care of that.

It’s STRONGLY ADVISED that you click “Close Net” when the net is done. 
Answer YES to confirm such...and this will also stop logging, close the chat 
window, announce in the AIM window that the net is closed, remove the net 
entry from the Netlogger website, and then save the net data to the Netlogger 
servers, for “recovery mode”, noted below. The net will then show up in the 
“Previous Nets” window for 30 days. Note that if you don’t do this, you are 
likely to get a warning message from the System Administrators, for doing an 
“improper logoff”, and you could be banned from future use of Netlogger, if 
these happen too often.

Now, if you lose power and internet during a net, that’s one thing. If you have 
a problem with power issues, consider getting a UPS (Uninterrupted Power 
Supply) unit, or a generator. To keep the internet connection, you may want 
an alternate device to your hard-lined internet, such as a Verizon Mi-Fi. But, 
keep both connections “active”, so if one fails, you’ll still be “online”. 

Once the net is closed, you can save the file via screenshots (detailed later), or 
to a delimited logfile (*.log), where it can be read via Windows Notepad, or 
another related program. 

Recovering Checkins From A Previous Net Log:

If your computer crashed after you closed the net, before you got the chance 
to save the log or screenshot to your computer, all is not lost. If you used the 
Netlogger servers, can choose View → Previous Nets. Then, select the desired 
net, and tell the system to “Load Checkins”. That way, you don’t have to try 
to reconstruct the entire net checkin log from memory!! You’ll need to do this 
within 30 days after the net has been closed. After that, the net info is gone!!



There’s also an option in Netlogger, where you can click on a particular 
station’s callsign, and it’ll bring up their profile on QRZ. To view full address 
information (including email), you will need to be “logged in” to QRZ.

Screenshots:

Depending on the screenshot utility you’re using, and the resolution of your 
computer monitor, there may be a limit on the amount of lines in a screenshot, 
for it to be readable. 

I originally did the screenshot via the utility from IObit (noted on the next 
page), then imported it into LibreOffice. Now, I just save it without importing 
it. If I have more checkins than that, I just create multiple screenshots. I use a 
program called IRFanView, and merge multiple screenshots into one.
Screenshot Utilities:

For the screenshots, several utilities are available. I personally use the utility 
with the IObit program software (https://www.iobit.com). While there are 
freeware versions, you have to run updates manually. Yearly subscriptions for 
these are available, and with some of them, you can use that program on three 
(3) separate computers at once. These are mainly for Windows systems. 

Once you have purchased a yearly subscription, you can choose to manually 
install updates (after being notified of such), or have the program install the 
updates automatically. At certain times, you can get these programs at special 
discounted rates; and at purchase time, you can set up “auto renewal”, to be 
charged to your credit or debit card. If you prefer, you can just have it set as 
“manual renewal”, and you will have to manually go in and take care of the 
payment online. The program will notify you when the key has expired.

Some of the programs are IObit Malware Fighter (with 3 virus protection 
engines), Driver Booster (keeps all your system drivers up to date), Smart 
Defrag (defragmenting hard drives or USB drives), Uninstaller (to remove 
unwanted programs), Advanced System Care (takes care of several options), 
Start Menu 8 (makes the Start Menu look like Windows 7 or 8 instead of 
Windows 10), and IObit Software Updater (updates current programs, and 
allows you to install recommended new ones). These will work with either 32-
bit or 64-bit Windows systems.

https://www.iobit.com/


Additional Options With Netlogger:

Edit → Preferences → check the desired boxes. Under Edit, you can also 
choose from several options, such as:

! To clear, insert, or delete a row. This is helpful if you entered the wrong 
callsign (fat finger syndrome) – but without fat fingers, how do you pick up 
the food and the silverware?? (hi hi). 

I normally don’t enter non-amateur radio callsigns (such as SWL Listeners).
This is because I have no idea who they may be…and you don’t want SWL 
listeners trying to checkin to a ham radio traffic net, where you have to have 
a license beforehand. Plus, I like to know who checked into a particular net.

! You can choose fonts and colors, plus column heights. 

! For contacts and checkins, you can add or remove the desired columns. 
For the checkins, I use the number (#) of the checkin, their callsign, State, 
Preferred Name, Remarks, City, State, Name, and Country (I no longer use 
the Status column). You can click on the name of the column to sort the data 
in a different way, and also use the mouse to make the columns as wide, or as 
narrow, as you desire. You can also copy the data at the top of a column, and 
move it to where you’d like, with the mouse.

By clicking on Edit → Checkins Table...or Edit → Contacts Table, look for 
“Enable/Disable Columns”. You can check or uncheck which ones you desire.

At the bottom of the screen, with the contacts, you can modify those windows 
under Edit → Contacts Table – and do the same as noted above with the 
Checkins table. 

As noted earlier, I don’t use the Contacts Table info during the nets (that’s 
why in the “sample net screenshot”, you don’t see this “other data”). If you 
use the “contacts table”, and have stations logged from there, Netlogger may 
automatically set their color to what I’ve chosen as “Mobile Or Portable”. If 
you do enter a station in the contacts, they’ll ALWAYS show up as the red 
orange for “Worked Station Manually”, with the W option in the status 
column.



Setup → Accounts → For QRZ, eQSL, and LoTW: 

You have to enter your login credentials (usually your callsign and password). 
As long as you have ONE of these set up, this will work for you. I have QRZ 
and eQSL, but not LoTW (Logbook Of The World). Note that you have to be 
an ARRL Member to use LoTW. While I’m a Life Member of ARRL, I don’t 
use LoTW...even though I received “a key” to use it at one time. Once you’ve 
got these configured, all you do is enter the station callsign (uppercase or 
lowercase), and data is automatically filled in for you. Note that if the servers 
are down, you won’t be able to obtain the needed data.

If a call doesn’t show up, check the FCC ULS (for a station in the United 
States or its territories), or a worldwide callsign server, such as the one with 
Buckmaster/Hamcall (located at https://hamcall.net/call – you will need to be 
logged in to get the full data. If you have previously purchased a callsign CD 
from Buckmaster, your password will be what you use on that site, along with 
your callsign, to login. Note that some countries have it, where the operator 
has requested that their contact data be kept from view.

If their preferred name is different (and you have that window enabled), you 
can modify that. As an example, my full name is Daryl J.D. Stout – J.D. was 
my late father’s name, but I’ve always gone by “Daryl”. As a side note, I was 
named after the motion picture director Daryl Zanick; while my brother was 
named after actor Dana Andrews. However, he has no interest in ham radio, 
or any of my other hobbies.

One of the nice features with Netlogger is if you try to enter a callsign that has 
already been entered, an asterisk appears (with nothing else); noting the entry 
is a duplicate...if you have set up Netlogger as such. However, you can allow 
duplicate entries under Function → Enable Duplicate Entries; although in 
doing so, you get “a false total”. If “enable duplicate entries” is disabled, you 
could re-type the callsign at the bottom, to note they have a recheck for the 
net. I did NOT note this in the sample net checkin screenshot, noted earlier in 
this document. This basically is used if the station has “a recheck”, and I can 
adjust the log later.

Using A Club Information File instead of QRZ, eQSL, or LoTW:

https://hamcall.net/call


Toward the top of this file, I noted setting up a user profile. Besides that, you 
can also create a Club Information Profile for each of your nets; and again, 
doing the user profiles or club information profiles, is OPTIONAL. Normally, 
if no club profile exists, it’ll show as [no club info] in the Remarks column.

If you’ve created a default profile for yourself (usually done under MISC), 
you can use the default profile...or you can create a separate profile for each 
net. Under Setup, the entry “Club Profile” is at the top. Selecting the desired 
club profile should be done before you choose the “Create A Net” option, 
noted earlier in this document.

Once you’ve done that, go to the log for that particular net. Once you have all 
the data as you want it...right click on the number to the left of the callsign, 
and at the bottom, it’ll say “Add/Update Club Info” (click on that). The next 
time they checkin to that particular net, it’ll have the info that you created for 
that callsign, instead of pulling it from eQSL, QRZ, or LoTW. It will no 
longer show [no club info] within the Remarks column; but, you can still 
enter whatever you want in the Remarks column.

For a list of nets that I do during the week, please point your web browser to 
http://www.wx4qz.net/elk.htm – and look for the file “Nets Where N5VLZ Is 
Net Control”. This was the main reason I redid this file (my previous net info 
had become obsolete), and I wanted to make some minor cosmetic changes.

Note that I did NOT cover everything that Netlogger does. Again, I created 
the file to get started with it to running a net as Net Control, or to monitor the 
log of a net in progress, and to checkin to that particular net.

I hope this file was a help, and if you have any questions or comments, please 
email me at either n5vlz@arrl.net, vhfnetmanager@qcwa.org, 
n5vlz@winlink.org, or to wx1der@gmail.com 

73, and I hope to hear you on the air soon.

Daryl Stout, N5VLZ, Little Rock, Arkansas
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